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INTRODUCTION TO THE SAS OROS SOFTWARE

THE OROS ADMINISTRATOR

The OROS Administrator is the program within the OROS suite that allows an authorized user to perform administration functions for the OROS programs. 

The Administrator provides the following functions.


- Adding OROS users


- Managing user rights to the OROS programs


- Managing OROS licenses


- Other miscellaneous OROS Administrator functions

NOTE: For a detailed description of the OROS Administrator functions, reference the 


 Help function in the OROS Administrator.

THE OROS MODELER

The SAS OROS Modeler software is designed to model organizational functions from an Activity-Based Costing perspective. Using the software, Resources, Activities, and Cost Objects can be defined, along with the associated cost assignments and drivers. 

Other functions of the modeling tool, such as; attributing, output quantities, and reporting, are available to enhance the information provided by and organization’s ABC model.

ADDING AN OROS USER USING THE ADMINISTRATOR
The following procedure will address the steps necessary to add an OROS user.

1. Left click on the Microsoft Windows Start button.

2. From the pop-up menus, select Programs, OROS v5.x, OROS Administrator.

3. Left-click on the OROS Administrator selection.

4. The OROS Login box will be displayed with Admin in the Name: field. 

NOTE: The Login box will also ask for a password. If a password has not been established for the Administrator, no password is required. In this case the Password: field should remain blank.

5. To enter the Administrator function, click OK.

The following screen should be displayed.
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6. Click on the Tools drop-down menu and select the Manage Users… option.

The following screen will be displayed.
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7. Click on the New User button.

8. Enter the following information for the new user.


- User login name in the Login Name: field.


- User password in the Password: field. (Leave blank)


- User Name: and Title: if applicable.

9. To assign solutions to the new user, use the following procedure.

- Highlight the desired solution in the Unassigned Solutions box on the left.

- Click on the [image: image3.png]


 button to assign the solution to the user.

- Click on the Save button to save the new user and solutions.

- Click on the Close button to close the Manage Users window.

The screen should look similar to the following example when completed.
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10. The new user Bob has RW (Read/Write) rights to the indicated Product 

      Assignments. 

OPENING THE OROS MODELER

To open the OROS Modeler, complete the following steps.

1. Left click on the Microsoft Windows Start button

2. From the pop-up menus, select Programs, OROS v5.x, OROS Modeler

3. Left-click on the OROS Modeler selection

4. Enter your OROS login name and password in the OROS Login box and click OK

The OROS Modeler program will open with a blank initial screen.

OPENING A NEW MODEL

To open a new model in the modeler, complete the following steps.

1. Click on the New Model button on the Modeler button bar. The button is the left most 

    icon button resembling a white sheet of paper. The Model Summary screen should be 

    displayed. See the example below.
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Model Summary screen example

2. From the Model Summary screen, the model Title (Not the file name), description and 

    module names can be entered. NOTE: In most cases the module names will remain the 

    same.

3. Click OK on the Model Summary screen. The Model Summary screen should 

    disappear, and the Resource module screen will be displayed.

4. To save the model:


- Click on the File menu drop-down


- Select the Save Model As… option


- Navigate to the desired directory folder for the model


- Enter the model name in the File Name box


- Click on the Save button

THE MODELING TOOL BUTTON BAR AND DROP-DOWN-MENUS
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Modeler button bar and drop-down menus

Button definitions left to right.
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- Create Center



- Destination View


- Create Account



- Multilevel View


- Create Cost Element



- Source View


- Calculate model 
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- Select Resource Module


- Expand Hierarchy, one step


- Select Activity Module


- Collapse Hierarchy, one step


- Select Cost Object Module


- Expand Hierarchy, all


- Select Scorecard Module
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- Select / Create Named Views


- Help

Drop-down menus – General descriptions

File: Contains functions related to file operations. Examples: Save, Open, Print,

Reports, Import / Export.

Edit: Contains edit operations. Examples: Copy, Paste, Create centers/accounts/cost elements, Add Attributes.

Model: Contains operations related to the model. Examples: Define Attributes, Define Drivers, Model Summary, Model Options.

Modules: Contains module selection and general module operations.

Period: Contains model period operations, Model / Period Notes, Model quantities operations.

View: Contains model view operations. Examples: Model views, Named Views.

Tools: Advanced modeling tools

Window: Microsoft window operations

Help: Model help files

BUILDING AN ABC MODEL

The following sections will present the steps required to create an ABC model and analyze model information using the SAS OROS modeling tool. The model will be based on the case study and “paper model” created at the beginning of the training. 

The model build will address:

1. Creating centers and accounts in the resource, activity and cost object modules

2. Creating entered cost elements in the resource module

3. Creating reference numbers

4. Creating a model period

5. Entering resource costs

6. Creating drivers 

7. Creating Resource and Activity assignments with drivers

8. Entering driver quantities

9. Calculating the model

10. Entering output quantities and displaying unit costs

11. Creating and assigning attributes

12. Model Reporting

13. Adding a new model period and period data

14. Comparing period data

1. CREATING CENTERS AND ACCOUNTS

The following steps will create centers and accounts in the Resource, Activity and Cost Object modules. Insure that the model is opened in the modeling tool.

RESOURCE MODULE CENTERS AND ACCOUNTS

1. Select the Resource module using the Resource module button on the button bar [image: image12.bmp]
2. Create 2 Centers under the Resource module center. Use the Create Center [image: image13.bmp] 

    button.

3. Click in the name field of the first center and enter the name Salaries. Name the 

    second center Other Expenses. The Resource module should look like the following 

    example.
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4. Highlight the Salaries center (Click on the Center icon), and create 2 Accounts within 

    the center using the Create Account [image: image15.bmp] button.

5. Click on the name field of the first account and enter the name Civilian Salaries. 

    Name the second account Military Salaries. The resource module should look like the 

    following example.
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6. Using the same procedure in the previous step, create 2 accounts in the Other 

    Expenses center and name them Travel and Supplies. 

The Resource module should look like the following example.
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7. Save the model

ACTIVITY MODULE CENTERS AND ACCOUNTS

1. Select the Activity module using the Activity module button on the button bar [image: image18.bmp]
2. Create 2 Centers under the Activity module center. Use the Create Center button  [image: image19.bmp]
3. Name the two centers Training Activities and Management & Admin Activities.

4. Create three Accounts within the Training Activities center using the Create Account 

    button [image: image20.bmp].  

5. Name the three accounts Assess Training Needs, Develop Training Courses, and 

    Deliver Training Courses. 

6. Create one account in the Management & Admin Activities center and name it 

    Perform Management and Administration.

The Activity module should look like the following example.
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7. Save the model

COST OBJECT MODULE ACCOUNTS

1. Select the Cost Object module using the Cost Object module button [image: image22.png]


.

2. Create three accounts in the Cost Object module.

3. Name the accounts Orientation Courses, Desktop Software Courses, and Custom 

    Courses.

The Cost Object module should look like the following example.

[image: image23.png][l =20= = = = A )

2% -2 BlEE 0 |

Name [ReferenceNu | Cost
3 Cost Object $0.00
S Orientation Courses 1 $0.00
& Deskiop Software Courses 2 $0.00
3 $0.00

& Custom Courses




4. Save the model

2. CREATING ENTERED COST ELEMENTS IN THE RESOURCE MODULE

The following steps will create entered Cost Elements in the Resource module. The cost elements are the part of the model structure that allow for the input of cost into the resource accounts.

1. Select the Resource module using the Resource Module button  [image: image24.bmp]
2. Highlight the Civilian Salaries account.

3. Create one cost element using the Create Cost Element button [image: image25.bmp]. 

4. Click in the name field of the cost element, and name the cost element Civilian 

    Salaries. 
5. Highlight the Military Salaries account and create one cost element. Name the cost 

    element Military Salaries. The Resource module should look like the following 

    example.

[image: image26.png]D|S(E&S| %[E|-] el 2F - [B Bk~

Name [ReferenceNu | Cost
SResource $0.00
Dsslaries 2 $0.00
&5 Chvilian Salaries 3 $0.00
L@ Civilian Sslaries 2 $0.00
S Military Salaries 2 $0.00
L@ Military Salaries 3 $0.00
ZA0ther Expenses 1 $0.00
Sravel 4 $0.00
83 supplies 5 $0.00




6. Create one cost element each for the Travel and Supplies. Name the cost elements 

    Travel and Supplies. 

The Resource module should look like the following example.
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7. Save the model

3. CREATING REFERENCE NUMBERS

Unique reference numbers must be assigned to all centers, accounts and entered cost elements created in the model. These unique reference numbers will replace the model-generated reference numbers.

The following steps will replace the model-generated reference numbers in the Resource, Activity and Cost Object modules.

1. Select the Resource module using the Resource Module button  [image: image28.bmp]
2. Click in the Reference Number column associated with the Salaries center.

3. Replace the existing reference number with the new reference number R-SAL.

4. Click in the Reference Number column associated with the Civilian Salaries account.

5. Replace the existing reference number with the new reference number R-SAL-CS.

6. Click in the Reference Number column associated with the Civilian Salaries entered 

    cost element.

7. Replace the existing reference number with the new reference number R-SAL-CS-CE.

8. Enter the new reference numbers below for the remaining centers, accounts, and 

    entered cost elements in the resource module.

Model Item



Reference Number

Military Salaries (Account)

R-SAL-MS

Military Salaries (Cost Element)
R-SAL-MS-CE

Other Expenses (Center)

R-OE

Travel (Account)


R-OE-TVL

Travel (Cost Element)


R-OE-TVL-CE
Supplies (Account)


R-OE-SUP

Supplies (Cost Element)

R-OE-SUP-CE

The Resource module should look like the following example.
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9. Select the Activity module using the Activity module button on the button bar [image: image30.bmp].

10. Enter the new reference numbers below for the centers and accounts in the activity 

      module.

Model Item






Reference Number

Training Activities (Center)




A-TA
Assess Training Needs (Account)



A-TA-ATN

Develop Training Courses (Account)



A-TA-DEVTC

Deliver Training Courses (Account)



A-TA-DELTC

Management & Admin Activities (Center)


A-MA

Perform Management and Administration (Account)
A-MA-PMA

The Activity module should look like the following example.
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11. Select the Cost Object module using the Cost Object module button on the button 

      bar [image: image32.png]


.

12. Enter the new reference numbers below for the accounts in the Cost 

      Object module.

Model Item




Reference Number

Orientation Courses (Account)

C-OC

Desktop Software Courses (Account)

C-DSC

Custom Courses (Account)


C-CC

The Cost Object module should look like the following example.
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13. Save the model.

4. CREATING A MODEL PERIOD 

Prior to entering resource costs or any other periodic data into the model, the model period for the data must be defined. The following steps will define a new model period for this exercise.

1. Click on the Period drop-down menu at the top of the modeling tool. A drop-down 

    box with a list of selections should be displayed.

2. Select the Define Periods… option. The Define Periods box should be displayed. See 

    the following example.
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3. Highlight Period 1 in the Periods: area. Period 1 should now be displayed within the 

    Definition area in the Name: field.

4. In the Name: field, replace Period 1 with the new period FY2002Q1.

5. Click on the Rename button.
The Define Periods screen should now look like the following example.
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6. Click on the OK button to close the Define Periods box.

7. Save the model.

5. ENTERING RESOURCE COSTS

The following steps will enter the cost for each resource in the resource module.

NOTE: Insure that the Period FY2002Q1is selected.

1. Select the Resource module using the Resource Module button  [image: image36.bmp].

2. Expand the Resource module to the cost element level.

3. Highlight the Cost associated with the Civilian Salaries cost element.

4. Enter the amount 300,000.

5. Highlight the Cost associated with the following cost elements and enter the associated 

    costs.


- Military Salaries,
88,000

- Travel,   

50,000

- Supplies,   

25,000

6. The Resource module should now look like the following example.
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7. Save the model

6. CREATING DRIVERS

The resource and activity drivers were defined for the case study at the beginning of the course. The following steps will create these drivers in the modeling tool.

1. Click on the Model drop-down menu at the top of the modeling tool. A drop-down 

    box with a list of selections should be displayed.

2. Click on the Define Drivers… option on the list.

3. The Define Drivers box will be displayed. See the example below.

[image: image38.png]Eej File Edit Model Modules Period View Tools Window Help

DS E[&]| &[E|el=] == (e

=IE B EEle | slalsl sl 2

e B

esoul

S35ak - Definition
Z%; Narme [EVENLY ASSIGNED Uptate
QL\ Sequencein Caleulafions———————
on| | QeenivToper [0 = | e sequence Number =
2 —=
=
Zgn‘ brertpel B =]l || Replece BiverGuarity vt
B | [ |
Diivers: =i N
Name Type [ Quantity Type T<]
g EVENLY ASSIGNED Basic Unique
PERCENTAGES Basic Unique





NOTE: There are two drivers that are inherent to the modeling tool. They are the 


 EVENLY ASSIGNED and PERCENTAGES drivers. 


- The EVENLY ASSIGNED driver evenly distributes the cost from the source 


  account to all destination accounts.


- The PERCENTAGES driver assigns the cost from the source account to all 


  destination accounts based on percentages. The sum of all percentages to all 


  destination accounts must total 100%.

4. Click on the New Driver button [image: image39.bmp] to create a new driver.

5. A new driver will be created. The new driver will be listed in the drivers area, and the 

    model-generated driver name, example: Driver 3, will appear in the Definition area in 

    the Name field.

    NOTE: For this exercise, all Driver Quantity Types will be Unique, and all Driver 
  
     Types will be Basic.

6. Replace the model-generated driver name in the Name field with # of FTEs.

7. Click on the Update button in the Define Drivers box. The driver name will be 

    changed in the drivers area and in the Name field. See the example below.
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8. Create the following additional drivers in the model.

9. Click on the New Driver button  [image: image41.bmp] , change the model-generated driver name in the 

    Name field to the new driver name, and click the Update button. Perform this 

    procedure for each new driver.


Additional Drivers:


% of Travel


% of Time


# of Assessments


# of Courses


Dollars

The Define Drivers box should look like the following example.
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10. Save the model.

7. CREATING RESOURCE AND ACTIVITY ASSIGNMENTS WITH DRIVERS

RESOURCE COST ASSIGNMENTS AND DRIVERS

The following steps will create the Resource to Activity cost assignments and add the associated drivers.

1. Select the Resource module using the Resource module button on the button bar [image: image43.bmp].

2. Expand the Resource module to the account level.

3. Select the Source View by clicking on the Source View button [image: image44.bmp] on the button bar.

4. Adjust the view to look like the following example.
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Source View button definitions - left to right:
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- Add Accounts. Adds accounts to the destination window.

- Show Accounts. Shows destination accounts for a selected source account.

- Clear Accounts. Clears the destination window. Does not delete assignments.

5. Add the activity accounts to the destination window on the right by performing the 

    following procedure.


- Click on the Add Accounts button [image: image47.bmp] on the Source View button bar


- The Add Accounts for Assignments box will be displayed. 


- See Example 1 following this procedure.


- Insure that the Activity radio button is selected in the module section and that 


  the Activity module center is highlighted in the Activity area.


- Click on the Add Accounts button.

The screen should look like the following example.
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- Click on the Close button.

The screen should look like the following example.
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6. The Civilian Salaries account in the Resource module will be assigned to all four of 

    the activities in the Destination window on the right. Use the following procedure to 

    make the assignments.


- Highlight the Civilian Salaries account in the Source window on the left.


- Small “Arrow heads” will appear to the left of the four activity accounts in the


  Destination window.


- Click on the arrow head to the left of the Assess Training Needs activity to 


  make the assignment.


- Click on the arrow heads to the left of the three remaining activities to make the 


  assignments.

The screen should look like the following example.

[image: image50.png]|EfES)

Name [ReferenceNumb [ DriverName Name ReferenceN | Driv
SResource Assess Training Needs [ATAATN

Dsalaries R-SAL /=5 Develop Training Caurses ATADEVTC

& Civilian Salaries P-SALCS EVENLY ASSIGI Deliver Training Courses ATA-DELTC

Siltary Selaries ReSALMS Perform Management and Adrministiation  AMAPMA
S10ther Expenses R-OE

Sravel R-OE-TVL

83 supplies PR-OE-SUP





7. Assign the # of FTEs driver to the Civilian Salaries cost assignment.


- Click in the DriverName column on the row associated with the Civilian


  Salaries account. (The EVENLY ASSIGNED driver is currently attached to the 


  assignment) A drop-down arrow should appear.


- Click on the drop-down arrow to view the drivers in the model.


- Click on the # of FTEs driver


- The # of FTEs driver is now attached to the cost assignment

8. Make the remaining Resource cost assignments and driver assignments using the 

    information below.

SOURCE ACCOUNT
DRIVER
DESTINATION ACCOUNTS
Military Salaries

# of FTEs
Develop Training Courses







Deliver Training Courses

Travel



% of Travel
Assess Training Needs







Deliver Training Courses







Perform Management and Administration

Supplies


Dollars

Develop Training Courses

9. Save the model

ACTIVITY COST ASSIGNMENTS AND DRIVERS

The following steps will create the Activity to Cost Object cost assignments and add the associated drivers.

1. Select the Activity module using the Activity module button on the button bar [image: image51.bmp].

2. Expand the Activity module to the account level.

3. Select the Source View by clicking on the Source View button [image: image52.bmp] on the button bar.

4. Adjust the view to look like the following example.
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5. Add the cost object accounts to the destination window on the right by performing the 

    following procedure.


- Click on the Add Accounts button [image: image54.bmp] on the Source View button bar


- The Add Accounts for Assignments box will be displayed. 


- Insure that the Cost Object radio button is selected in the module section and 

  that all of the cost objects are selected. (While holding down the Ctrl key, click 

  on each of the cost objects.)


- Click on the Add Accounts button.

The screen should look like the following example.
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- Click on the Close button.

The screen should look like the following example.
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6. The Assess Training Needs account in the Activity module will be assigned to all 

    three of  the cost object accounts in the Destination window on the right. Use the 

    following procedure to make the assignments.


- Highlight the Assess Training Needs account in the Source window on the left.


- Small “Arrow heads” will appear to the left of the three cost object accounts in 


  the Destination window.


- Click on the arrow head to the left of the Orientation Courses cost object to 


  make the assignment.


- Click on the arrow heads to the left of the two remaining cost objects to make 


  the assignments.

The screen should look like the following example.
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7. Assign the # of Assessments driver to the Assess Training Needs cost assignment.


- Click in the DriverName column on the row associated with the Assess 


  Training Needs account. (The EVENLY ASSIGNED driver is currently 


  attached to the assignment) A drop-down arrow should appear.


- Click on the drop-down arrow to view the drivers in the model.


- Click on the # of Assessments driver


- The # of Assessments driver is now attached to the cost assignment

8. Make the following Activity cost assignments and driver assignments using the 

    information below.

SOURCE ACCOUNT
DRIVER
DESTINATION ACCOUNTS

Develop Training Courses
# of Courses
Orientation Courses







Desktop Software Courses







Custom Courses

Deliver Training Courses
# of Courses
Orientation Courses







Desktop Software Courses







Custom Courses

NOTE: Do not exit the Source View for the Activity module. The next procedure will make the cost assignment for the Perform Management and Administration activity.

9. Save the model

INDIRECT ACTIVITY COST ASSIGNMENTS AND DRIVER

It was determined that the Perform Management and Administration activity had more of a causal relationship to the activities in the organization than to the cost objects. 

The following steps will assign the Perform Management and Administration activity to the other activities in the model.

1. Insure that the Activity module is selected and that the Source View is displayed.

2. If the Cost Objects are displayed in the Destination window, click on the Clear 

    Accounts button [image: image58.bmp]. 

    NOTE: The Clear Accounts button does not break the cost assignments. It only clears 

     the Destination window.

3. Add the activity accounts to the destination window on the right by performing the 

    following procedure.


- Click on the Add Accounts button [image: image59.bmp] on the Source View button bar. 

- The Add Accounts for Assignments box will be displayed. 


- Insure that the Activity radio button is selected in the module section and that 


  the Activity module center is highlighted in the Activity area.


- Click on the Add Accounts button.


- Click on the Close button.

The Source View should look like the following example.
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4. The Perform Management and Administration account in the Activity module will 

    be assigned to selected activities in the Destination window on the right. Use the 

    following procedure to make the assignments.


- Highlight the Perform Management and Administration account in the 


  Source window on the left.


- Small “Arrow heads” will appear to the left of the four activity accounts in the


  Destination window.


- Click on the arrow head to the left of the Assess Training Needs activity to 


  make the assignment.

5. Click on the arrow heads of the following activities to make the assignments.

SOURCE ACCOUNT
DRIVER
DESTINATION ACCOUNTS
Perform Management 

% of Time 
Develop Training Courses

and Administration 



Deliver Training Courses

6. Assign the % of Time driver to the Perform Management and Administration cost 

    assignment.


- Click in the DriverName column on the row associated with the Perform 


  Management and Administration. A drop-down arrow should appear.


- Click on the drop-down arrow to view the drivers in the model.


- Click on the % of Time driver


- The % of Time driver is now attached to the cost assignment

The screen should look like the following example.
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7. Save the model.

8. ENTERING DRIVER QUANTITIES

The driver quantities for the Resource and Activity assignments were defined in the case study at the beginning of this course. The following steps will enter these quantities for the model assignments.

ENTERING RESOURCE ASSIGNMENT DRIVER QUANTITES

NOTE: Insure that the Period FY2002Q1 is selected.

1. Select the Resource module using the Resource module button on the button bar [image: image62.bmp].

2. Expand the Resource module to the account level.

3. Select the Source View by clicking on the Source View button [image: image63.bmp] on the button bar.

4. Highlight the Civilian Salaries resource account

5. Click on the Show Accounts button on the Source View button bar [image: image64.bmp].

6. Adjust the Source View to look like the following example.
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7. The number of FTEs will be entered for each activity associated with Civilian and 

    Military Salaries. 

    To enter the number of FTEs (Driver quantity) for the Civilian Salaries, complete 

    the following steps.


- Click on the Driver Quantity number (The default is 0.00) in the 


  DriverQuantity column corresponding to the Assess Training Needs activity.


- Enter the quantity  5.


- Click on the Driver Quantity corresponding to the Develop Training Courses 


  activity.


- Enter the quantity  3.

- Enter the Driver Quantities for the remaining two activities.

RESOURCE

DRIVER QUANTITY
ACTIVITIES
Civilian Salaries

10


Deliver Training Courses





  2


Perform Management and 








Administration


The Resource module Source View should look like the following example.

[image: image66.png]]I IS]

S Name [ReferenceNum| DriverName Name ReferenceN| DriverQuantity |
[ SResource Assess Training Needs. JaTa-ATN 500

DSalaries R-BAL &S Develop Training Courses ATA-DEVTC 300

S Chvilian Salaries  R-BALCS #0fFTEs &8 Deliver Training Courses ATADELTC 1000

S Military Salaries  R-SALMS #0of FTEs L- &8 Perform Management and Administration  A-MA-PMA 200
CA0ther Expenses R-OE

Sravel PrOE-TVL % of Travel

= Supplies R-0E-SUP Dallars





8. Enter the Driver Quantities (# of FTEs) for the Military Salaries by performing the 

    following steps.

- Highlight the Military Salaries resource account

- Click on the Show Accounts button on the Source View button bar [image: image67.bmp].

- Enter the Driver Quantities for the two activities.

RESOURCE

DRIVER QUANTITY
ACTIVITIES
Military Salaries

2


Develop Training Courses





5


Deliver Training Courses


9. Enter the Driver Quantities for the two remaining resource accounts.

Resource: Travel

Driver:  % of Travel

RESOURCE

DRIVER QUANTITY
ACTIVITIES
Travel



30


Assess Training Needs







60


Deliver Training Courses





10


Perform Management and 








Administration


Resource:  Supplies

Driver:  Dollars
RESOURCE

DRIVER QUANTITY
ACTIVITIES
Supplies


25,000 

Develop Training Courses

ENTERING ACTIVITY ASSIGNMENT DRIVER QUANTITES

NOTE: Insure that the Period FY2002Q1 is selected.

1. Select the Activity module using the Activity module button on the button bar [image: image68.bmp].

2. Expand the Activity module to the account level.

3. Select the Source View by clicking on the Source View button [image: image69.bmp] on the button bar.

4. Highlight the Assess Training Needs activity account

5. Click on the Show Accounts button on the Source View button bar [image: image70.bmp].

6. Adjust the Source View to look like the following example.
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7. The number of assessments will be entered for each cost object associated with the 

    Assess Training Needs activity. 

    To enter the number of  assessments (Driver quantity) for each cost object assignment, 

    complete the following steps.


- Click on the Driver Quantity number (The default is 0.00) in the 


  DriverQuantity column corresponding to the Orientation Courses cost object.


- Enter the quantity  20.

- Enter the Driver Quantities for the remaining two cost objects.

ACTIVITY


DRIVER QUANTITY
COST OBJECTS
Assess Training Needs

15


Desktop Software Courses






20


Custom Courses

The Source View should look like the following example.
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8. Enter the Driver Quantities (# of Courses) for the Develop Training Courses activity 

    by performing the following steps.

- Highlight the Develop Training Courses activity account

- Click on the Show Accounts button on the Source View button bar [image: image73.bmp].

- Enter the Driver Quantities for the three cost objects.

ACTIVITY


DRIVER QUANTITY
COST OBJECTS
Develop Training Courses

20


Orientation Courses






15


Desktop Software Courses






20


Custom Courses

9. Enter the Driver Quantities for the two remaining activity accounts.

Activity: Deliver Training Courses

Driver:  # of Courses

ACTIVITY


DRIVER QUANTITY
COST OBJECTS
Deliver Training Courses

25


Orientation Courses






75


Desktop Software Courses






15


Custom Courses

Activity:  Perform Management and Administration
Driver: % of Time
ACTIVITY


DRIVER QUANTITY
ACTIVITY

Perform Management


20


Assess Training Needs

And Administration


30


Develop Training Courses






50


Deliver Training Courses

10. Save the model.

9. CALCULATING THE MODEL

The resource costs and all driver quantities should now be entered into the model. The following steps will calculate the model for the period FY2002Q1 to flow all costs to the Activity and Cost Object module accounts.

1. Click on the red calculator button [image: image74.bmp] on the button bar.

The following screen should be displayed.
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2. In the Calculate area, select the All Modules radio button.

3. Insure the period FY2002Q1 is displayed in the Period area.

4. Insure that the Actual radio button is selected in the Data Type area.

5. Click on the Calculate button.

The following is an example of the calculation results. There should be no Errors or Warnings at this time. If there are, the causes should be identified and corrected prior to proceeding with the next exercises.
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6. Close the Calculation Summary by clicking on the [image: image77.bmp] in the upper right of the  

    Calculation Summary screen.

7. Save the model.

10. ENTERING OUTPUT QUANTITIES AND DISPLAYING UNIT COST

One of the objectives of the case study is to calculate the unit cost for each of the three categories of training courses offered by the training organization. The unit cost will be calculated by the modeling tool, and will be based on the quantity of classes offered for each category of courses.

The modeling tool calculates the unit cost by dividing the total cost of each course category by the number of courses completed for each category. 

The following steps will enter the quantity (OutputQuantity) of courses for each course category.

NOTE: Insure that the Period FY2002Q1 is selected.

1. Select the Cost Object module and display the Multilevel view.

2. Right-click on the blank column header to the right of the Cost column.

3. A drop-down menu will be displayed.

4. Left-click on the Add Column option. The Add Column box will be displayed.

The screen should look like the following example.
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5. Before adding columns, insure that the following options are set in the Add Columns 

    box.


- The Property tab is selected.


- The Actual radio button is selected in the Numeric area.


- In the Period area, select the Select Period option and insure the period 


  FY2002Q1 is displayed in the period window.

6. Use the drop-down arrow in the Property window to select the UserOutputQty 
    property.

7. Click the Add button to add the UserOutputQty column.

8. Use the drop-down arrow in the Property window to select the UnitCost property.

9. Click the Add button to add the UnitCost column.

10. Click the Close button to close the Add Column box.

The screen should look like the following example.
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11. The following steps will enter the output quantities and display the unit cost.


- Click in the UserOutputQty column corresponding to the Orientation Courses 


  row.


- Enter the amount  25.

- Repeat this step for the two remaining course categories.


COURSE CATEGORY

UserOutputQty


Desktop Software Courses


75


Custom Courses



15

12. Calculate the model for the period FY2002Q1 for all modules.

The screen should look like the following example.
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NOTE: Notice the change in the UnitCost as the UserOutputQty is entered. The 


displayed UnitCost is the average unit cost for each course category.

13. Save the model.

11. CREATING AND ASSIGNING ATTRIBUTES

Two groups of attributes will be created for this case study. The attributes will be used to identify the different resource and activity accounts. Once the attributes have been created, they will be assigned to the resource and activity accounts.

CREATING ATTRIBUTES

The following steps will create the attributes in the model.

1. Click on the Model drop-down menu.

2. Select the Define Attributes… option.

3. The Define Attributes box will be displayed. See the following example.
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4. Complete the following procedure to create two attribute centers.


- In the Attribute Type drop-down box select Center.


- In the Definition area, type Resource Type in the Name: field.


- Click on the Create button.


- The Resource Type attribute center should now be listed in the Attributes area.


- In the Definition area, type Activity Type in the Name: field.


  NOTE: Insure that the Center option is still selected.


- Click on the Create button.

The screen should look like the following example.
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4. Complete the following procedure to create the attributes in the Resource Type 

    attribute center.


- Highlight the Resource Type center in the Attributes area.


- In the Attribute Type drop-down box select Text.


- In the Definition area, type Civilian Salaries in the Name: field.


- Click on the Create button.


- Use the above procedure to create the two remaining text attributes in the 


  Resource Type center.



Attributes: Military Salaries,  Other Expenses

The screen should look like the following example.
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5. Complete the following procedure to create the attributes in the Activity Type 

    attribute center.


- Highlight the Activity Type center in the Attributes area.


- In the Attribute Type drop-down box insure that Text is selected.


- Create the following two text attributes in the Activity Type center.



Attributes: Training Activities,  Admin Activities

The screen should look like the following example.
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6. Click on the Close button to close the Define Attributes box.

7. Save the model.

ASSIGNING ATTRIBUTES 

The attributes created in the preceding steps will be assigned to the resource and activity accounts. 

NOTE: There are several methods used to assign attributes. The following procedure will assign the attributes in a way that will display the assignments in the module screens.

The following steps will assign the Resource Type attributes to the resource accounts.

1. Select the Resource module by clicking on the Resource module button [image: image85.bmp].

2. Insure that the Multilevel view is selected.

3. Right-click on the blank column header to the right of the Cost column.

4. A drop-down menu will be displayed.

5. Left-click on the Add Column option. The Add Column box will be displayed.

The screen should look like the following example.
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6. Select the Attribute tab. The two attribute centers should be displayed in the Attribute 

    Hierarchy area.

7. Highlight the Resource Type attribute center.

7. Click the Add button to add the Resource Type attribute column.

8. Click on the Close button.

9. Expand the Resource module to the account level.

The Resource module should look like the following example.
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10. Use the following procedure to assign the Civilian Salaries attribute to the Civilian 

      Salaries account.


- Click on the row corresponding to the Civilian Salaries account in the 


  Resource Type column. 


- Click on the drop-down arrow to display the attributes.
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- Double-click on the Civilian Salaries attribute.

The screen should look like the following example.
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11. Use the following procedure to assign the Military Salaries attribute to the Military 

      Salaries account.


- Click on the row corresponding to the Military Salaries account in the 


  Resource Type column. 


- Use the drop-down arrow to display the attributes.


- Double-click on the Military Salaries attribute.

12. Assign the Other Expenses attribute to the Travel and Supplies accounts.

The screen should look like the following example.
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13. Referencing steps 1 through 12, assign the following Activity Type attributes to the 

      listed activities.

ACTIVITY



ACTIVITY TYPE ATTRIBUTE
Assess Training Needs


Training Activities

Develop Training Courses


Training Activities

Deliver Training Courses


Training Activities

Perform Management and


Admin Activities

Administration

The screen should look like the following example.
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14. Save the model.

12. MODEL REPORTING

The modeling tool has built-in reports that display model structure and model data. The following reports are examples of some of the common uses for the modeling tool reports. The reports will include: Model Drivers, Model Attributes, Attribute Costs, Unit Costs, and Resource Contributions.

DISPLAYING MODEL DRIVERS

The following steps will generate reports that will display the drivers used by the source accounts in the Resource and Activity modules. 

1. Click on the File drop-down menu at the top of the modeling tool. A drop-down box 

    with a list of selections will be displayed.

2. Click on the Generate Reports… option on the list.

The following screen should be displayed.
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3. Click on the Drivers option in the Model Reports window on the right.

4. The FY2002Q1 period should be displayed in the Period window.

5. Click on the Options…button.

The following screen should be displayed.
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6. The Options window allows the selection of some formatting options for the report. 

    Select the following options.


- Check the boxes for the Output ‘$’,’%’and ‘,’ and Show Calculation 


  Warning options.


- Select the Screen radio button and New Window box options.


- The Column Widths options should be set to Name: 40 and Reference No.: 25.


- Click on the OK button.

7. Click on the Select Data… button on the Generate Reports screen. 

The following screen should be displayed.
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8. The Select Data window allows the selection of the data for the report.


- Select the Resource module radio button.


- Select the All radio button for the Centers/Accounts option.


- Select the Include Centers and Accounts option.


- Click on the OK button.

9. Click on the Select Attributes… button on the Generate Reports screen.

The following screen should be displayed.
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10. The Select Attributes box allows the selection of attributes for the report. 


- Select the Ignore Attributes radio button. No attributes are associated with this 


  report.


- Click on the OK button.

11. Click on the Report button on the Generate Reports screen.

The following screen should be displayed.
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12. The Driver report.

- The Header displays information about the report.

- The body of the report lists the Resource drivers and the source accounts that the 

  drivers are assigned to.

13. To close the report, click on the [image: image97.bmp] button in the upper right of the report screen. 

14. Run a report to display the Activity drivers by using the preceding steps with the 

      following option change.


- Select the Activity module in the Select Data option on the Generate Reports 


  screen.

DISPLAYING MODEL ATTRIBUTES

The following steps will generate a report that will display the attribute assignments in the Resource and Activity module.

1. Select the Generate Reports… option from the File drop-down menu.

2. Select Attributes in the Model Reports window.

3. Click on the Options… button.

4. Select the following options in the Options box.


- Check the boxes for the Output ‘$’,’%’and ‘,’ and Show Calculation 


  Warning options.


- Select the Screen radio button and New Window box options.


- The Column Widths options should be set to Name: 40 and Reference No.: 25.


- Click on the OK button.

5. Click on the Select Data… button on the Generate Reports screen. 

6. Select the following options in the Select Data box.


- Select the Resource module radio button.


- Select the All radio button for the Centers/Accounts option.


- Select the Actual Data Type. 

- Do not select Budget Data Type or the Sort Data options.


- Select the Include Centers and Accounts option.


- Do not select the Include Cost Elements option.


- Click on the OK button.

7. Click on the Select Attributes… button on the Generate Reports screen.

- Select the Ignore Attributes radio button. No attributes selections are necessary 

  to run this report.


- Click on the OK button.

8. Click on the Report button on the Generate Reports screen.

The following screen should be displayed.
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9. The Attributes report.

- The Header displays information about the report.

- The body of the report lists the Resource accounts and the attribute assignments.

  NOTE: No attributes are assigned to the resource centers.

10. Run a report to display the Activity attribute assignments by using the preceding 

      steps with the following option change.


- Select the Activity module in the Select Data option on the Generate Reports 


  screen.

THE ATTRIBUTE COSTS REPORT

The following steps will generate a report that will display the account costs by attribute  in the Resource and Activity module.

NOTE: Prior to running this report, the model must be calculated for the period 


FY2002Q1.

1. Select the Generate Reports… option from the File drop-down menu.

2. Select Attribute Costs in the Model Reports window.

3. Insure that the period FY2002Q1 is displayed in the Period window.

4. Click on the Options… button.

5. Select the following options in the Options box.


- Check the boxes for the Output ‘$’,’%’and ‘,’ and Show Calculation 


  Warning options.


- Select the Screen radio button and New Window box options.


- The Column Widths options should be set to Name: 40 and Reference No.: 25.


- Click on the OK button.

6. Click on the Select Data… button on the Generate Reports screen. 

7. Select the following options in the Select Data box.


- Select the Activity module radio button.


- Select the All radio button for the Centers/Accounts option.


- Select the Actual Data Type. 

- Do not select Budget Data Type or the Sort Data options.


- Select the Include Centers and Accounts option.


- Do not select the Include Cost Elements option.


- Click on the OK button.

8. Click on the Select Attributes… button on the Generate Reports screen.


- Click on the Use Selections radio button.


- Highlight the Activity Type attribute center.


- Do not select the Hide Detail option.


- Click on the OK button.

9. Click on the Report button on the Generate Reports screen.

The following screen should be displayed.
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9. The Attribute Costs report.


- The Header displays information about the report.


- The body of the report displays the activity accounts grouped by attribute. 

- The costs of the attribute groups are totaled to display the total attribute cost of  

  each activity grouping.

10. Run the report again for the Activity module. This time select the Hide Detail option 

      in the Select Attributes… section. How does this differ from the first report?

11. Run the Attribute Cost report for the Resource module using the Resource Type 

      attributes.

THE UNIT COSTS REPORT

The following steps will generate a report that will display the unit costs of the accounts in the Cost Object module. 

NOTE: Prior to running this report, the model must be calculated for the period 


FY2002Q1.

1. Select the Generate Reports… option from the File drop-down menu.

2. Select Unit Costs in the Model Reports window.

3. Insure that the period FY2002Q1is displayed in the Period window.

4. Click on the Options… button.

5. Select the following options in the Options box.


- Check the boxes for the Output ‘$’,’%’and ‘,’ and Show Calculation 


  Warning options.


- Select the Screen radio button and New Window box options.


- The Column Widths options should be set to Name: 40 and Reference No.: 25.


- Click on the OK button.

6. Click on the Select Data… button on the Generate Reports screen. 

7. Select the following options in the Select Data box.


- Select the Cost Object module radio button.


- Select the All radio button for the Centers/Accounts option.


- Select the Actual Data Type. 

- Do not select Budget Data Type or the Sort Data options.


- Select the Include Centers and Accounts option.


- Do not select the Include Cost Elements option.


- Click on the OK button.

8. Click on the Select Attributes… button on the Generate Reports screen.


- Click on the Ignore Attributes radio button.


- Click on the OK button.

9. Click on the Report button on the Generate Reports screen.

The following screen should be displayed.
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10. The Unit Costs report.


- The Header displays information about the report.


- The Unit Cost for each of the courses is displayed, along with the total account 


  cost and Output Quantity (No. Units).


  NOTE: The Unit Cost calculation: Total account cost / Output Quantity

THE RESOURCE CONTRIBUTIONS REPORT

The Resource Contributions report looks for cost contributions for selected accounts at the furthest point along the model assignment paths, and will report on contributions from any module in the model. Report options can designate contributions with or without the selection of attributes.

The following steps will generate reports, using selected report options, to display the cost contributions for the Cost Objects in the model. 

NOTE: Prior to running the reports, the model must be calculated for the period 


FY2002Q1.

1. Select the Generate Reports… option from the File drop-down menu.

2. Select Resource Contributions in the Model Reports window.

3. Insure that the period FY2002Q1 is displayed in the Period window.

4. Click on the Options… button.

5. Select the following options in the Options box.


- Check the boxes for the Output ‘$’,’%’and ‘,’ and Show Calculation 


  Warning options.


- Select the Screen radio button and New Window box options.


- The Column Widths options should be set to Name: 40 and Reference No.: 25.


- Click on the OK button.

6. Click on the Select Data… button on the Generate Reports screen. 

7. Select the following options in the Select Data box.


- Select the Cost Object module radio button.


- Select the All radio button for the Centers/Accounts option.


- Select the Actual Data Type. 

- Do not select Budget Data Type or the Sort Data options.


- Select the Include Centers and Accounts option.


- Select the Include Cost Elements option.


- Click on the OK button.

8. Click on the Select Attributes… button on the Generate Reports screen.


- Click on the Ignore Attributes radio button. (At this time, no attributes will be 


  selected)


- Click on the OK button.

9. Click on the Report button on the Generate Reports screen.

The following screen should be displayed.
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10. The Resource Contributions report.


- The Header displays information about the report.


- The body of the report displays the cost contributions from the Resource module 


  to the three Cost Objects. The cost contributions are displayed in dollars and the 


  percentage of contribution.


- The “$” to the left of the contributions indicate the there are Entered Cost 


  Elements.

The following steps will run the Resource Contributions report using Attributes.

1. Run a Resource Contributions report to display the contributions to the Cost Objects 

    by following the preceding steps, and using the following options.

2. Click on the Select Data button and un-check the box for the Include Cost Elements 

    option.

3. Click on the Select Attributes… button. 


- Click on the Use Selections radio button.


- Highlight the Resource Type attribute center.


- Do not select the Hide Detail or Hide Non-Attr Contributions options.

4. Run the report.

The screen should look like the following example.
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5. The report displays the cost contributions from the attributed Resource accounts.

6. Run the report again selecting the Hide Detail option in the Select Attributes… 

    section. What does the Hide Detail option do to the results of the report?

7. Run the Resource Contributions report using the following options to view the 

    contributions from the Management and Administration activity to the three cost 

    objects.


- Click on the Select Attributes… button. 


- Click on the Use Selections radio button.


- Double-click on the Activity Type attribute center to view the individual

  attributes.


- Highlight the Admin Activities attribute.


- Do not select the Hide Detail or Hide Non-Attr Contributions options.


- Run the report.

The screen should look like the following example.
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8. The report display.


- Since only the Admin Activities attribute was selected, the contributions from 


  the Resource module are now showing as Non-Attr Contributions.


- The Perform Management and Administration activity is showing as the 


  attributed contribution as a result of the Admin Activities attribute selection 


  option for this report.

13. ADDING A NEW MODEL PERIOD AND PERIOD DATA

The following scenario will address adding a new period to the existing model, importing new period data through the use of text files, and performing selected data comparisons between periods.

ADDING A NEW MODEL PERIOD

The following steps will add a new period to the model.

1. Click on the Period drop-down menu.

2. Select Define Periods… from the menu selection list.

The following screen should be displayed.
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3. In the Name: field, type in the new period FY2002Q2.

4. Click on the Create button.

The following screen listing the two model periods should be displayed. 
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5. Click on the OK button.

6. Select the new period, FY2002Q2, by using the following procedure.


- Click on the Period drop-down menu.


- Select Select Period… from the menu selection list.


- Highlight the period FY2002Q2 in the Select Period box.


- Click on the OK button.

7. Select the Resource module and observe the costs for the accounts. Look at the costs 

    in the Activity and Cost Object modules. Since the period data; resource costs, driver 

    quantities, and output quantities have not been entered for the new period, the 

    FY2002Q2 model period will have no costs.

IMPORTING PERIOD DATA FOR THE PERIOD FY2002Q2

There are several methods to enter the new period data into the model. For this exercise, the data will be imported into the period FY2002Q2 through the use of text files. 

The modeling tool is designed to import text files directly into the model. The following steps will address the importing of resource costs, resource driver quantities, activity driver quantities, and output quantities for the new period FY2002Q2. 

The first step for importing the data, is the creation of text file templates that can be used to enter the data for the new period.

Complete the following procedure to create a template for the resource costs, and import the new costs into the model.

1. Click on the File drop-down menu.

2. Select Export File… from the drop-down list.

The following screen will be displayed.
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3. Highlight the Cost_Actual selection in the Export window.

4. Select the period FY2002Q2 in the Period drop-down window.

5. Click on the Options… button.

The following screen will be displayed.
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6. Click on the Specify Filename… button. 

The following screen will be displayed.
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7. Select the Desktop from the Save in: drop-down.

8. Enter the file name RCA in the File Name: field.

9. Click on the Save button.

10. Click on the OK button on the Options screen.

11. Click on the Select Data… on the Export File screen.

The following screen will be displayed.
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12. Select the Resource module radio button, and the All radio button.

13. Click on the OK button.

14. Click on the Export button on the Export File screen. 

      NOTE: A text file RCA.txt has now been created on the Desktop. 

15. Open the RCA.txt file in Excel (Notepad if Excel is not available).

Adjust the view to look like the following example.
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16. The text file displays the following information.


- Rows 1 through 5 are the required header information for the text file. Notice 


  that row 3 defines the Resource module, and row 4 defines the type of file.


- Row 6 is the model period. When the data is imported from this file to the 


  model, the data will be entered into the period specified in row 6, column B


- Rows 7 through 10 are the Entered Cost Elements in the Resource module. 


  The new cost for the period FY2002Q2 will be entered in column C.

17. Enter the following costs for FY2002Q2 in column C.

COST ELEMENT

COST
Civilian Salaries

350,000

Military Salaries

  88,000

Travel



  60,000

Supplies


  35,000

18. Save the file as a text file with the same name, RCA.txt.

19. The following procedure will import the RCA.txt file for the period FY2002Q2 into 

      the model.


- In the modeling tool, select the File drop-down menu.


- Select the Import File… option.

The following screen will be displayed.
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- Select the Desktop in the Look in: window.


- Select the RCA.txt file in the File Name: window.


- Click on the Open button.


- An Import Summary screen will be displayed. The screen should indicate no 


  Errors or Warnings. Close the summary screen by clicking on the [image: image112.bmp] button on 


  the upper right of the summary screen.

20. The resource costs for the period FY2002Q2 have been imported into the model.

21. Save the model.

22. View the resource costs for the period FY2002Q2 in the model.


- Select the Period drop-down menu.


- Select the Select Period… option.


- Highlight the period FY2002Q2.


- Click the OK button.


- Select the Resource module. The new costs should be displayed.

Complete the following procedure to create a template for the resource driver quantities, and import the new driver quantities into the model.

1. Select the File Drop-down menu.

2. Select the Export File… option.

3. Select the following options.


- Highlight the Driver_Quantities_Actual option in the Export window.


- Select the period FY2002Q2 in the Periods drop-down.


- Click on the Options… button. 


- Click on the Specify Filename… button.


- Save the file name RDQA to the desktop by clicking on the Save button.


- Exit the Options screen by clicking on the OK button.


- Click on the Select Data… button.


- Select the Resource and All radio buttons. Click on the OK button.


- Click on the Export button on the Export File screen.

4. Open the RDQA.txt file in Excel.

Adjust the screen to look like the following example.
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5. The text file displays the following information for the resource assignments.


- Rows 1 through 5 are the required header information for the text file. Notice 


  that row 3 defines the Resource module, and row 4 defines the type of file.


- Row 6 is the model period. When the data is imported from this file to the 


  model, the data will be entered into the period specified in row 6, column B


- Rows 9 through 14 outline the information for source / destination assignments. 


  Row 9 = Driver, Row 10 = Source account, Rows 11 – 14 = Destination 


  accounts with driver quantities.


- Rows 15 to the end of the file follow the same pattern and outline the source / 


  destination information for the remaining resource assignments.

6. Enter the new resource driver quantities for the period FY2002Q2 in column D of the 

    RDQA file.

SOURCE

DESTINATION

DRIVER QTY
DRIVER
Civilian Salaries
Assess Training Needs

5

# of FTEs




Develop Training Courses

3




Deliver Training Courses

10




Perform Management 


2




and Administration

Military Salaries
Develop Training Courses

2

# of FTEs





Deliver Training Courses

5

Travel


Assess Training Needs

30

% of Travel




Deliver Training Courses

60




Perform Management 


10




and Administration

Supplies

Develop Training Courses

35000

Dollars

7. Save the file as a text file with the same name, RDQA.txt.

8.  The following procedure will import the RDQA.txt file for the period FY2002Q2 into 

      the model.


- In the modeling tool, select the File drop-down menu.


- Select the Import File… option.


- Select the Desktop in the Look in: window.


- Select the RDQA.txt file in the File Name: window.


- Click on the Open button.


- An Import Summary screen will be displayed. The screen should indicate no 


  Errors or Warnings. Close the summary screen by clicking on the [image: image114.bmp] button on 


  the upper right of the summary screen.

9. The resource driver quantities for the period FY2002Q2 have been imported into the 

    model.

10. View the resource driver quantities for the period FY2002Q2 in the model.


- Select the Period drop-down menu.


- Select the Select Period… option.


- Highlight the period FY2002Q2.


- Click the OK button.


- Select the Resource module – Source View. 


- Click on the source accounts to view the new driver quantities.

11. Calculate the model for the period FY2002Q2.

12. Select the Activity module.

13. All costs from the Resource module should be assigned to the Activity module.

14. Save the model.

Complete the following procedure to create a template for the activity driver quantities, and import the new driver quantities into the model.

1. Select the File drop-down menu.

2. Select the Export File… option.

3. Select the following options.


- Highlight the Driver_Quantities_Actual option in the Export window.


- Select the period FY2002Q2 in the Periods drop-down.


- Click on the Options… button. Click on the Specify Filename… button.


- Save the file name ADQA to the desktop by clicking on the Save button.


- Exit the Options screen by clicking on the OK button.


- Click on the Select Data… button.


- Select the Activity and All radio buttons. Click on the OK button.

- Click on the Export button on the Export File screen.

4. Open the ADQA.txt file in Excel.

Adjust the screen to look like the following example.
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5. The text file displays the following information for the activity assignments.


- Rows 1 through 5 are the required header information for the text file. Notice 


  that row 3 defines the Activity module, and row 4 defines the type of file.


- Row 6 is the model period. When the data is imported from this file to the 


  model, the data will be entered into the period specified in row 6, column B


- Rows 9 through 13 outline the information for source / destination assignments. 


  Row 9 = Driver, Row 10 = Source account, Rows 11 – 13 = Destination 


  accounts with driver quantities.


- Rows 14 to the end of the file follow the same pattern and outline the source / 


  destination information for the remaining activity assignments.

6. Enter the new activity driver quantities for the period FY2002Q2 in column D of the 

    ADQA file.

SOURCE

     DESTINATION

DRIVER QTY 
DRIVER
Perform Management 
     Assess Training Needs

20

% of Time

and Administration
     Develop Training Courses

30




     Deliver Training Courses

50

Assess Training Needs    Orientation Courses

25

# of 




     Desktop Software Courses

20

Assessments 




     Custom Courses


  5

Develop Training
     Orientation Courses

25

# of Courses 

Courses

     Desktop Software Courses

20

 




     Custom Courses


10

Deliver Training 
     Orientation Courses

30

# of Courses 

Courses

     Desktop Software Courses

90

 




     Custom Courses


10

7. Save the file as a text file with the same name, ADQA.txt.

8.  The following procedure will import the ADQA.txt file for the period FY2002Q2 into 

      the model.


- In the modeling tool, select the File drop-down menu.


- Select the Import File… option.


- Select the Desktop in the Look in: window.


- Select the ADQA.txt file in the File Name: window.


- Click on the Open button.


- An Import Summary screen will be displayed. The screen should indicate no 


  Errors or Warnings. Close the summary screen by clicking on the [image: image116.bmp] button on 


  the upper right of the summary screen.

9. The activity driver quantities for the period FY2002Q2 have been imported into the 

    model.

10. View the activity driver quantities for the period FY2002Q2 in the model.


- Select the Period drop-down menu.


- Select the Select Period… option, and highlight the period FY2002Q2.


- Click the OK button.


- Select the Activity module – Source View. 


- Click on the source accounts to view the new driver quantities.

11. Calculate the model for the period FY2002Q2.

12. Select the Cost Object module.

13. All costs from the Resource module should now be assigned to the Activity and Cost 

      Object modules.

14. Save the model.

Complete the following procedure to create a template for the User Output quantities, and import the new quantities into the model.

1. Select the File Drop-down menu.

2. Select the Export File… option.

3. Select the following options.


- Highlight the Output_Quantities_Actual option in the Export window.


- Select the period FY2002Q2 in the Periods drop-down.


- Click on the Options… button. Click on the Specify Filename… button.


- Save the file name COOQA to the desktop by clicking on the Save button.


- Exit the Options screen by clicking on the OK button.


- Click on the Select Data… button.


- Select the Cost Object and All radio buttons. Click on the OK button.

- Click on the Export button on the Export File screen.

4. Open the COOQA.txt file in Excel.

Adjust the screen to look like the following example.
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5. The text file displays the following information for the activity assignments.


- Rows 1 through 5 are the required header information for the text file. Notice 


  that row 3 defines the Cost Object module, and row 4 defines the type of file.


- Row 6 is the model period. When the data is imported from this file to the 


  model, the data will be entered into the period specified in row 6, column B


- Rows 8 through 10 outline the information for the Cost Objects. The new output 


  quantities for the Cost Objects will be entered in column C.

6. Enter the new output quantities for the period FY2002Q2 in column C of the COOQA 

    file.

COST OBJECT

OUTPUT  QUANTITY

Orientation Courses


30

Desktop Software Courses

90

Custom Courses


10

7. Save the file as a text file with the same name, COOQA.txt.

8.  The following procedure will import the COOQA.txt file for the period FY2002Q2 

     into the model.


- In the modeling tool, select the File drop-down menu.


- Select the Import File… option.


- Select the Desktop in the Look in: window.


- Select the COOQA.txt file in the File Name: window.


- Click on the Open button.


- An Import Summary screen will be displayed. The screen should indicate no 


  Errors or Warnings. Close the summary screen by clicking on the [image: image118.bmp] button on 


  the upper right of the summary screen.

9. The user output quantities for the period FY2002Q2 have been imported into the 

    model.

10. View the user output quantities and unit costs for the period FY2002Q2 in the model.


- Select the Period drop-down menu.


- Select the Select Period… option.


- Highlight the period FY2002Q2.


- Click the OK button.


- Calculate the model for the period FY2002Q2.


- Select the Cost Object module.


- The new output quantities can be viewed in the UserOutputQty column.


- The UnitCost column displays the unit costs for the period FY2002Q2.

11. Save the model.

14. COMPARING PERIOD DATA

In the following exercises, cost comparisons will be displayed in the Cost Object and Activity modules. The cost comparisons will display the period costs for FY2002Q1 and FY2002Q2 and the variances between the period costs. The variances between the periods will be displayed through the use of calculated columns. In addition, Named Views will be added in each module to save the created column configurations.

COMPARING THE COST AND UNIT COST IN THE COST OBJECT MODULE
The following steps will add columns in the Cost Object module to compare the Costs and Unit Costs for the two model periods.

NOTE: Calculate the model for the periods FY2002Q1 and FY2002Q2.

1. Select the Cost Object module.

2. For this exercise the ReferenceNumber and UserOutputQty columns will not be 

    needed. 


- Right click on the ReferenceNumber column header.


- Select the Delete Column from the menu.


- Repeat the above steps for the UserOutputQty column.


- The only columns that should be displayed are the Name, Cost, and UnitCost.

3. The Cost and UnitCost columns will be re-named and assigned to a selected period.


- Double click on the Cost column header.

The following screen will be displayed.
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- Enter CostQ1 in the Title field.


- Select the Select Period radio button, and use the drop down arrow to select the 


  FY2002Q1 period


- Click the OK button.


- Double click on the UnitCost column header.


- Enter UnitCostQ1 in the Title field.


- Select the Select Period radio button, and use the drop down arrow to select the 


  FY2002Q1 period


- Click the OK button.

4. Two additional columns will be added to display the Cost and UnitCost for the period 

    FY2002Q2.


- Right click on the blank column header to the right of the UnitCostQ1 column.


- Select the Add Column option.

The following screen will be displayed.
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- Select the Property tab.


- Select the Cost property using the drop down arrow in the Property: field.


- Change the title in the Title: field to CostQ2.


- Click on the Select Period radio button and select FY2002Q2.


- Click the Add button.


- Select the UnitCost property in the Property: field.


- Change the title to UnitCostQ2.


- Click on the Select Period radio button and select FY2002Q2.


- Click the Add button.


- Click the Close button.

The screen should look like the following example. The column widths may have to be adjusted.
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5. Two calculated columns will be added. One column will display the variance between 

    the Cost for the two periods, and the second column will display the variance between 

    the UnitCost for the two periods.


- Right click on the blank column header to the right of the UnitCostQ2 column.


- Click on the Add Column option.


- The Add Column screen will be displayed.


- Click on the Calculated tab.

The following screen will be displayed.
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- In the Title field enter CostQ1-Q2.


- Double click on the CostQ1 column in the window on the left. The CostQ1 


  should now appear in the Expression: window in parenthesis.


- Double click on the Minus sign (-) in the window on the right. The minus sign 


  should now appear in the Expression: window.


- Double click on the CostQ2 column in the window on the left.

The screen should now look like the following example.
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- Click on the Add button. This will add the column for the cost variance between 


  FY2002Q1 and FY2002Q2.


- Enter UnitCostQ1-Q2 in the Title: field.


- Delete ALL entries in the Expression: field.


- Double click on the UnitCostQ1in the column window on the left.


- Double click on the Minus (-) sign.


- Double click on the UnitCostQ2 in the window on the left.

The screen should now look like the following example.
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- Click on the Add button. This will add the column for the unit cost variance 


  between FY2002Q1 and FY2002Q2.

- Click the Close button on the Add Column screen.

The Cost Object screen should look like the following.
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5. Save the model.

6. A Named View will be created to save the column configurations created in the Cost 

    Object module. The Named View function allows the user to create, save, and display 

    different column configurations for a selected module. 


- Click on the Named View button [image: image126.bmp] on the button bar.

The following screen will be displayed.
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- Highlight the Model folder in the Named Views window. This will create a 


  Named View specific to this model.


- Click on the New View button [image: image128.bmp] .

A new view will be displayed in the New Views window. The default for the new view is Named View1.
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- Re-name the Named View1 view to Cost Object Variances.


- Click the OK button to save the view.


NOTE: The Named View Cost Object Variances will be displayed on the blue 


banner at the top of the modeling tool. 


To return to this Named View when another view has been selected, click on the 


Named View button and select the Cost Object Variances Named View.

7. Save the model.

The Cost Object module should look like the following example.
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COMPARING ACTIVITY COSTS

1. Select the Activity module.

2. Expand the module to the account level.

3. Delete the ReferenceNumber and Activity Type columns.

4. Configuring the Cost columns.


- Double click on the column header for the existing Cost column.


- Title the column CostQ1.


- Click on the Select Period radio button, and select the period FY2002Q1.


- Click on the OK button.


- Right click on the blank column header to the right of the CostQ1 column.


- Select the Add Column option.


- In the Property tab, select Cost, and title the column CostQ2.


- Click on the Select Period radio button, and select the period FY2002Q2.


- Click on the Add button. Do not exit the Add Column screen.

5. Select the Calculated tab in the Add Column screen.


- Create the formula “CostQ1”-“CostQ2” in the Expression: area by double 


  clicking on the selections.


- Title the column CostQ1-Q2.


- Click the Add button.


- Click the Close button.

6. Create the Named View Activity Variances for this column configuration in the 

    Named View Model folder.

7. Save the model.

The Activity module should look like the following example.
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